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FOURTH grade primary - second semester 

Information and communication technology  

lessons (1-4) Review - paper (1) 

 

Q1: Traveling by trains and planes has become easier because of the possibility of 
booking tickets through  ……………………  

A Internet B travel companies C booking offices 

Q2: …………… helped citizens to communicate, exchange information . 
A Schools B companies C digital tools 

Q3: There is an abundance of reliable information available to everyone thanks 
to............ website . 

A YouTube B EKB C Facebook 

Q4: Among the services provided by……………… site is the  date and schedules of 
exams. 

A Ministry of Health B Ministry of Tourism C Ministry of Education 
Q5: Your family wants to buy tickets for the opening ceremony of the Grand 
Egyptian Museum. You must go to the website of ………………………… 

A Ministry of Health B Ministry of Tourism C Ministry of Education 
Q6: The ability to use digital technology in an ethical, responsible and safe manner  

A digital citizenship B digital footprint C digital piracy 

Q7: A record of everything you do online, including the websites you visited. 
A digital citizenship B digital footprint C digital piracy 

Q8: Illegally trading content with the aim of sharing it or selling it to others. 
A digital citizenship B digital footprint C digital piracy 

Q9: Which of the following situations illustrates commitment to responsibilities 
while using the Internet? 

A Not to hack protected 
content 

B Using the internet 
when needed 

C Sharing information 
freely 

Q10: As a digital citizen, you have the right to ……………… 
A No one copies your 

digital footprint 

B Showing positive 
behavior with others 

C Evaluating what you 
see and share 

Q11: The Egyptian government has provided many digital tools that aim for a 
successful educational system, such as ................... 

A Digital books and 
activities 

B Educational 
channels 

C Both of them  

Q12: For students  who cannot leave their homes, the necessary contact with 
teachers is provided by …………. 

A social media  sites B video sharing 
platforms 

C digital devices 

Q13: If you want to learn how to prepare a healthy meal, you can search through ….. 
A Social media 

platforms 

B Video sharing 
platforms 

C Egyptian Knowledge 
Bank 
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FOURTH grade primary - second semester 

Information and communication technology  

lessons (1-4) Review - paper (2) 

 

Q14:………… Enables you to work with your classmates virtually on a project outside 

the school. 

A Social media 

platforms 

B Video sharing 

platforms 

C Egyptian Knowledge 

Bank 

Q15: A friend of yours wants to learn about the history of ancient Egypt, which 

platform would you recommend? 

A Social media 

platforms 

B Video sharing 

platforms 

C Egyptian Knowledge 

Bank 

Q16: Among the common messaging applications ............................................ 

A WhatsApp B Facebook C Skype 

Q17: One of the common virtual meeting applications is …………………………. 

A WhatsApp B Facebook C Skype 

Q18: Among the popular social media platforms ………………………………. 

A WhatsApp B Facebook C Skype 

Q19: Which of the following situations is suitable for synchronous 

communication? 

A Calling the police to  

report  

B Asking a friend about 

a trip 

C Calling a classmate to 

talk  

Q20: one of  the forms of synchronous communication via the Internet is ? 

A recorded tutorials B e-mail C instant video chats 

Q21: synchronous connection is appropriate when ………… 

A between people who 

do not know each 

other 

B between friends or 

family members 

 

C between people 

asking you a question 

that needs thinking 

Q22: …… allows you  to communicate in groups, usually focusing on one topic only. 

A chat rooms B instant messaging C video chats 

Q23: It is a form of asynchronous communication and is considered more formal 

than instant text messages. ................. 

A video chats B chat rooms C email 

Q24: Asynchronous communication does not require the presence of …………… to 

transfer files or information between two people. 

A instant response B computer C internet 
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FOURTH grade primary - second semester 

Information and communication technology  

lessons (1-4) Review - paper (3) 

 

Complete the following sentences with suitable words from the brackets: 

 

)Digital footprint - Egyptian Knowledge Bank - piracy - digital citizenship - 

chat rooms - synchronous communication( 

1-Egyptian citizens are allowed access to study materials. through..............  

2-The process of communication between individuals or the exchange of 

information at the same time is called ...............................  

3- You can, through ..................................., write a comment for the people who 

share the room with you.  

4-………………… enables you to use digital technology in an ethical, responsible 

and safe manner.  

5- ……… ……enables you to form an image of a person through his responses 

and actions online.  

 

(Digital piracy - Asynchronous - Skype - Synchronous - Computer with Camera - 

WhatsApp) 

1- You need to ………………… when you have a video chat.  

2- Sending a text message via e-mail to a colleague of yours is considered a 

type of ........................ communication. 

3- The copying of digital content by a person without the permission of its 

owner for the purpose of selling it is called ……………….. 

4 - When the information is urgent, it is preferable to use 

………………..…..communication.  

5- The .................... application is used to conduct group video chats.  
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FOURTH grade primary - second semester 

Information and communication technology  
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Put the word (true) in front of the correct statement and the word (false) in 
front of the incorrect statement as follows: 

1 You can copy scientific content without the permission of its owner  

2 
Every trace a person leaves when using the Internet is known as digital 
citizenship 

 

3 Skype is an asynchronous communication method  
4 Achieving digital citizenship entails a set of rights and duties  

5 
One of the applications of asynchronous communication is instant video 
chatting 

 

6 
It is important to have morals and etiquette when interacting with others on 
the Internet 

 

7 
Synchronous communication is appropriate when it is between close 
family members 

 

8 
Asynchronous communication is appropriate when information is 
important and quick action is needed 

 

9 
One of the digital citizenship responsibilities is making sure that how you 
use the Internet is evaluated 

 

10 
As a digital citizen, you do not have the right to share information and 
entertainment 
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Q1: To start........... you can create a link and send it to the participants 
A video chat B chat room C Instant messages  

Q2: To make a video chat, make sure that  .........  is turned on  
A Microphone B Camera C Both together 

Q3: If your ........on, anyone participating in the video chat will be able to see you. 

A Microphone B Camera C Both together 
Q4: Anyone who has access to ………… will be able to read your messages. 

A chat rooms B instant messaging C e-mail 
Q5: In ........ you can simply write your comment and send it. You can also reply to 
messages. 

A chat rooms B instant messaging C e-mail 
Q6: …………….Is a fun and informal way to communicate. 

A chat rooms B instant messaging C e-mail 

Q7: In ............. short phrases are used instead of complete sentences in addition to 
symbols and images. 

A chat room B instant messaging C e-mail 

Q8: You can send long text messages online  through ........................ . 
A video chat B instant messaging C e-mail 

Q9: The last step to do instant messaging is …………. 
A write a message B press send C click the contact list 

Q10: It is common to use ……… in more formal messaging situations 
A chat rooms B instant messaging C e-mail 

Q11: You have to use ………… to create an account on the Egyptian Knowledge Bank . 
A chat rooms B instant messaging C email 

Q12: To send an email to someone. Type his email address in the ………………… field. 
A "To" B "subject" C "attachments" 

Q13: You must provide clear information about the e-mail message in the …….. field. 
A "To" B "subject" C "attachments" 

 Q14: When sending information through ………..….. make sure that it is safe and  
A "To" B "subject" C "attachments" 

 Q15: Which of the following websites can your teacher use for Teaching online 
A  Edmodo B  Facebook C  Egyptian Knowledge Bank 

 Q16:  ..... is the first online library in Egypt that contains sources on a various  topics. 
A  Egyptian Knowledge 

Bank 

B  National Geographic 
Kids 

C vlaby 

 Q17: You can search and view various digital articles and video clips through  …………  
A  Egyptian Knowledge 

Bank 

B  National Geographic 
Kids 

C vlaby 
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Q18: The ......... is a virtual laboratory platform that enables students and teachers to 
conduct interactive laboratory experiments. 

A Egyptian Knowledge 

Bank 

B National Geographic 

Kids 

C Vlaby 

Q19: It is possible to conduct …………………..laboratory experiments through the 
Flappy platform in an interesting way. 

A Virtual B Real  C Both of them  
Q20: children were able to find information about animals, science and history 
online through …………….. 

A Egyptian Knowledge 

Bank 

B National Geographic 

Kids 

C Vlaby 

Q21: Which of the following sources of learning would you recommend to a friend 
who wants to conduct an experiment to find out the boiling point of water? 

A mapmaker Interactive   B Vlaby C Egyptian Knowledge 
Bank 

Q22: …………… Provides online mapping tools for students and teachers 
A mapmaker Interactive   B Vlaby C Egyptian Knowledge 

Bank 
Q23: A feature provided by National Geographic, which allows the use of topics 
and tools related to maps 

A mapmaker Interactive   B Egyptian Knowledge 

Bank 

C National Geographic 

Kids 

Q24: Ahmed wrote a research on tourism in Egypt. He quoted part of the research 
from the Egyptian Knowledge Bank, so he must  … ………..... 

A Referring to the 

publishers  

B Publishing without 

referring 

C Sharing and selling 
without permission 

Q25: When conducting digital research, your plan must include  .…………………………  
A Unreliable 

information 

B Details far from the 

research topic 

C An introduction to the 

research topic 

Q26: It is necessary for your research plan to include  .…………  
A Questionable 

information 

B Supporting 

paragraphs  

C Digital blogs 

Q27: When conducting a research, it is necessary to mention ……… in the final 
report of the research 

A Articles B Outline  C Information sources 
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FOURTH grade primary - second semester 

Information and communication technology  

lessons (5-8) Review - paper (3) 

Q28: Articles written by experts who have verified their validity are considered 
……………….sources.  

A  Reliable   B  Unreliable   C  Electronic 
 Q29: Facebook, wikis and blogs are ……………. sources because they may contain 
false information 

A  Reliable   B  Unreliable   C  Electronic 
 Q30: Which of the following situations is useful for synchronous communication? 

A  Calling the 
emergency police 

B  Find out the flight 
time of a friend  

C  Talking with a 
classmate 

 Q31: synchronous communication is useful when …. ………………… 

A 
 between people who 
do not know each 
other 

B 
between friends and 

family members C 
The answer needs 

thought and 
preparation 

 Q32:  synchronous communication is useful when ……………….……. 
A  Between people who 

do not know each 
other 

B  The information is 
urgent 

C  The answer requires 
thinking and 
preparation 

 Q33: Asynchronous communication is useful when  ...................... 
A  The information is 

urgent 

B between friends and 
family members 

C  The answer requires 
thought and 
preparation 

Q34: Asynchronous communication is useful when  ……………….….  
A  Between people who 

do not know each 

B  The information is 
urgent 

C  The answer does not 
require thinking and 
preparation 
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lessons (5-8) Review - paper (4) 

Complete the following sentences with suitable words from the brackets: 

(Video chat - send - phone / video - e-mail - instant messaging - chat rooms) 
1-When writing a message with …………….. be sure to use grammatical rules, 
salutations and closing phrases                                                                                                                                                                                                            
2- To reply to a video chat, you must click  the………… icon during chat                

3-To join ............... you have to click on its link and wait until you are allowed to enter  

4- After you have finished writing an instant message, you must click on the 
.............. icon                                                                                                                                                                                                                                                                                                          .  
5 -  …………… is a fun and informal way to communicate, through images  and short 
phrases                                                                                                                                                                                     
 

Complete the following sentences with suitable words from the brackets: 

(Vlaby - Egyptian Knowledge Bank - Edmodo - Email - National Geographic 
Kids - Map Maker Interactive) 

1- students can communicate with their teachers to follow up on their 
lessons through ………………..platform                                                                                                    
2- ……………… Provides online mapping tools for students and teachers. 
3 - ………………… allows you to search and view various topics and digital articles                        

 

4-................ platform enables students to conduct virtual laboratory 
experiments                                                                                                                                                                             

5-............ is a popular online resource that enables children to learn about 
animals and science                                                                                                                                        

 
 

Complete the following sentences with suitable words from the brackets: 

(Chat rooms - unreliable sources - Egyptian Knowledge Bank - 
asynchronous communication - Map Maker Interactive - synchronous 

communication) 
1- The  communicating between individuals or exchanging information at the 
same time is called …………………                                                                                             

2- In ………………. You can write a comment for the people who share the room 
with you.                                                                                                                                                                                     
3 - ……………. platform enables you to use related data and tools with maps.  

4 - Sending a message via e-mail to your teacher, is a type of ………….. 
5 - Information full of opinions and errors is………………….                
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FOURTH grade primary - second semester 

Information and communication technology  

lessons (5-8) Review - paper (5) 

Put the word (true) in front of the correct statement and the word (false) in 
front of the incorrect statement as follows: 

1 Anyone can enter a video chat without the permission of the chat creator  
2 In video chats, no one can see you if your camera is off  
3 You cannot reply or comment on messages in chat rooms  
4 To create an account on the EKB website, you must use the e-mail  
5 In video chats, you should dress appropriately and act as if you were in a public place  

6 Email is a fun and informal way to communicate  
7 When using instant messaging, check grammar and use salutations   
8 EKB is the first digital library containing various sources and topics  
9 vlaby allows you to conduct lab experiments in a virtual environment  

10 Mapmaker Interactive provides online mapping tools for students and teachers  

11 Unreliable sources are usually professionally presented and misspelled  
12 Beware of taking information from wikis as they may be full of errors   
13 An outline helps you present the information in your report in a logical way  

14 
Online communication includes both synchronous and asynchronous, and 
you have to choose the appropriate type for each situation 

 

15 Scientific content may be copied without the permission of its owner  

16 
You can write your research without indicating the source from which you 
got the information 

 

17 Every trace a person leaves when using the Internet is known as digital citizenship  
18 Skype is an asynchronous communication method  
19 the email address to which the message is sent can be written in the subject field  
20 Achieving digital citizenship entails a set of rights and duties  

21 
It is possible to find information about space science and history in the map 
maker interactive  

 

22 
You can communicate with an unknown person on the Internet without 
consulting your family members 

 

23  Instant Video Chats - Live TV Shows are  asynchronous Communication  
24 It is important to have morals and etiquette when dealing with others online  
25 Edmodo allows teachers and students to communicate and learn online  

26 map maker interactive is one of the safe sites for research and data collection  
27 Facebook, wikis, and blogs are unreliable sources  
28 Synchronous communication is useful when it is between close family members  

29 
Asynchronous communication is useful when information is important and 
quick reply is needed 

 

30 National Geographic Kids enables you to conduct science experiments interactively  

31 
It is necessary that your research outline includes (introduction-
paragraphs-conclusion) about the information presented 

 

32 It is imperative that your project includes some unreliable information  
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Q1: Gautam Shah founded …………… organization to connect people with wildlife 
around the world. 

A National Geographic B Internet of Elephant C Global Health 
Q2: Gautam Shah works as ……………….. expert in many countries 

A Information 
Technology 

B Cultural Human 
Sciences 

C Social Sciences 

Q3: Protecting animals in their natural habitats means ……………… conservation 

A marine life B social life C wild life 
Q4: Gautam Shah believes in using ……… to bring wildlife into people’s daily 
interests. 

A Zoos B Schools , universities C Technology , games 
Q5: using  …………… and data visualization effects allow people to interact with 
animals virtually 

A Augmented Reality B Bluetooth C Internet of Things 
Q6: ….. lets you virtually see the real environment of the things you would like to see 

A Augmented Reality B Bluetooth C Internet of Things 

Q7: If I make a scientific guess about how things happened, this is …………………  
A Construct a 

Hypothesis 
B Test  a  

Hypothesis 
C Characteristics of the 

hypothesis 
Q8: .............. is an attempt to answer your question with an explanation that can be tested. 

A Construct a 
Hypothesis 

B Test  a  
Hypothesis 

C Characteristics of the 
hypothesis 

Q9: During …………….. make sure that you Do not conduct any test which is not safe! 
A Construct a 

Hypothesis 
B Test  a  

Hypothesis 
C Characteristics of the 

hypothesis 

Q10: ............... the problem helps you to solve it gradually, by achieving one small 
step after another 

A Identify B Breaking down C Comprehend 
Q11: Your teacher asked you to organize a trip for the class. You have to start first 
with ................ to make it easier to accomplish what was asked of you. 

A Know the number of 
students 

B Determine the 
itinerary 

C Divide it into small 
tasks 

Q12:............ includes different options to choose from: PowerPoint, Word, and 
Publisher. 

A Office 365 B Skype C Email 
Q13: A.................... is the space left around the edges of your poster or billboard. 

A Limit B Margin C Direction 
Q14:If you include content …………… to the edge, it will appear cramped of poster . 

A too close B too far C Constant 
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Q15: Having a fixed margin of ................. will help design a good poster. 

A 2 mm B 25 mm C 25 cm 
Q16: If you add content that is too close to the edges, this makes the poster ............. 
from a visual point of view. 

A Plain B Attractive C Cramped 
Q17: Choosing ……………… Font When presenting a poster or billboard, your 
audience will have to strain to read the information. 

A Too small B Too big C Simple  
Q18: Choosing ……………. Font When presenting a poster or billboard , you’ll have to 
limit the amount of information you share. 

A Too small B Too big C Simple  
Q19: It is better not to use more than ……… colors in the poster, taking into 
consideration the background color. 

A Three B Four C Five 
Q20: You have to use ………….quality design images in the poster, provided that they 
are clear and appropriate to the subject. 

A Low B Medium C High 

Q21: One of  various sources of information............. It consists of books, articles, 
newspapers and encyclopedias 

A Print   B Internet C Interviews 

Q22: Specialized search engines and digital learning sites from various sources of 
information in  ..…………  

A Print   B Internet C Interviews 

Q23: Through …………… you can evaluate the information you have obtained and see 
if it is reliable or not. 

A How current is the 
information? 

B presenting with a bias 
or unbiased? 

C Both of them  

Q24:............... allows you to create a spreadsheet with as many columns and rows 
as you need. 

A Word B Excel C PowerPoint 

Q25 ……………….is often used to present numbers as the program can add up 
numbers automatically. 

A Word B Excel C PowerPoint 

Q26:............ allows you to write whatever you want. in a variety of ways. 
A Word B Excel C PowerPoint 

Q27: Through ......... you can change the design, add photos, and link your report to 
websites or  information online   

A Word B Excel C PowerPoint 
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Complete the following sentences with suitable words from the brackets: 
)Augmented Reality - Technology and Games - Internet or Elephant - Information 

Technology - Wildlife - National Geographic( 
1- Gautam Shah founded …………….. organization to connect people with wildlife around 
the world.    
 2 - Gautam Shah works as ……………….. expert in many countries  

 3-Protecting animals in their natural habitats means .............  conservation  
4- ………... lets you virtually see the real environment of the things you would like to see  
5 - Gautam believes in using ….… to bring wildlife into people’s daily interests.  

 

Complete the following sentences with suitable words from the brackets: 
(break down - Margin - Office 365 - Hypothesis Test - Excel - Hypothesis Construct) 

1-If I make a scientific guess about how things happened, this is considered …….. 

2-During …….. make sure that you Do not conduct any test which is not safe! 
3-............... problems Helps in solving them gradually. By achieving one small step after 
another. 

4-…… includes different options to choose from: PowerPoint, Word, and Publisher.  
 5-A.................... is the space left around the edges of your poster or billboard. 

 

Complete the following sentences with suitable words from the brackets: 
)three - high – too  close - very large - Cramped – four( 

 1- If you include content …………… to the edge, it will appear cramped of poster  
2- If you include content too close to the edge, this makes the poster .............  
3- Choosing ……………. Font When presenting a poster or billboard , you’ll have to limit the 
amount of information you share. 
4- It is better not to use more than ……… colors in the poster, taking into consideration the 
background color.  
 5-You must use ………….. quality images in the poster, provided that they are clear and 
appropriate to the subject.  

 

Complete the following sentences with suitable words from the brackets: 
 (Internet - Excel - unbiased - Word - printed – PowerPoint) 

1-Books, articles, newspapers, and encyclopedias from…………….. information sources  
2-Specialized search engines and digital learning sites from multiple sources of 
information on …………  
3-That the information presented with…………..this makes it reliable.  
4:........... allows you to create a spreadsheet with as many columns and rows as you need.  
5-........... allows you to write what you want. Present your ideas in a variety of ways.  
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Put the word (true) in front of the correct statement and the word (false) in front of the 
incorrect statement as follows: 

1 Gautam founded National Geographic to connect between people and wildlife  
2 Gautam Shah has worked as an IT expert in many countries  
3 Technology and games can be used to bring wildlife into people's daily  life  
4 Augmented reality allows you to see the real environment of things virtually  
5 Augmented reality technologies help present information to you in an interactive way.  
6 Augmented reality effects and data can be viewed through a mobile phone  
7 Gautam Shah worked to attract children's attention to wildlife through mobile games  

8 
Gautam Shah collects data on the locations of wild animals through the Global 
Positioning System 

 

9 When making a guess to solve a problem, this guess is called "hypothesis".  

10 Your success in solving the problem means your success in testing your hypothesis.  
11 In the hypothesis testing, a guess is made about how the problem occurred.  
12 When testing a hypothesis, do not take any action that puts you in dander  
13 It is important to break down problems into smaller sections when solving   
14 Excel includes various options for designing a poster or billboard  

15 
To access Microsoft 365’s bundle, you will need an updated digital device that supports 
the program 

 

16 
It doesn't matter to leave an empty space between the edges of the poster or billboard 
and its content 

 

17 If you add content too close to the edges of the poster it will look more visually appealing  
18 If you add content too close to the edges of the poster it will make it cramped  
19 Having a fixed margin such as 25 mm helps you create a well-designed poster  
20 When you present a poster, your audience should be able to see your information easily  
21 Always make sure to choose an easy-to-read font size when presenting a poster   
22 It is preferable to choose a very large font size in the design for easy reading of the text  
23 Choosing too small font size helps make your billboard easier for your audience to read  
24 It is preferable not to use more than three colors in the poster  
25 The background color does not matter when choosing the font color for the poster  
26 You can use low quality images in your poster design  
27 The images you use must match the content you share on the billboard  

28 
Interviews with people who have experienced the topic are among the many sources of 
research 

 

29 In the event that the information is presented with bias, it is from your reliable sources  

30 
You can assess the reliability of a source of information by the sources and evidence it 
provides 

 

31 
Your reliance on facts and be far from opinions helps you evaluate sources of 
information 

 

32 Word allows you to create a spreadsheet with as many columns and rows as you need  

33 
Excel is often used to present numbers as the program can add up numbers 
automatically. 

 

34 Through Word, you can write what you want and present your ideas in a variety of ways  
35 You can link your report in Word to websites or information online  
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 Q1: Search engines use ............ to provide results, which determine the most 
relevant results for your search. 

A Algorithms B Databases C keywords 
Q2: …………… is a series of steps that explain how to do a task. 

A Algorithms B Databases C keywords 
Q3: Computers and applications use ………………… to perform specific tasks. 

A Algorithms B Databases C keywords 
Q4: It is very important to choose a specific …………… when you are trying to collect 
information. 

A Algorithms B Databases C keywords 
Q5: ................. is writing multiple algorithms to create a complete program. 

A Design B Coding C Keywords 
Q6: You can create  animations and games using ………………. 

A code B algorithm C search engines 

Q7: Many websites such as …………… can help you learn coding. 
A wordpress.org B wikipedia.org C Code.org 
Q8: You can create mazes on ……………… website. It is an example of what you can 
create using coding. 

A wordpress.org B wikipedia.org C Code.org 
Q9:  ………………… is one of the popular programs to create your own drawings or edit 
images on computers 

A Microsoft paint  B WordPress C PowerPoint 

Q10: at the top  of the opening screen in  Paint program includes .............. 
A menu bar B toolbox C Both of them 

Q11:In MS Paint  ………………. Includes options for opening and saving files 
A menu bar B scroll bar C title bar 

Q12: The editing features on the ………. include the ability to edit colors and images. 
A menu bar B scroll bar C title bar 

Q13: The …………….. includes all the tools that you will need to make your drawing. 
A menu bar B toolbox C title bar 

Q14: You can fill colors in paint for a shape using the .................... tool 
A eraser B pencil C fill with color 

Q15: You can Select areas of the photo to use in your drawing by …………...  
A Cropping B Brush C Rotate 

Q16: ……… program also offers graphic tools such as shapes and 3D models. 
A Word B Skype C Whatsapp 

Q17: to see the different options of graphic tools word, click on the ........ tab. 
A home B insert C view 

 

محمود ياسين ( –جروب ) كوكب ةي سي    



FOURTH grade primary - second semester 

Information and communication technology  

lessons (5-8) THEME(4) Review - paper (2) 

  
Q18: word program provides many graphic tools such as .................. 
A Icons B 3D models C Both of them 
Q19: To create a presentation using PowerPoint, click on ………………….... 

A Blank presentation B Sample templates C New from an existing 
Q20: At the …………… of the screen, you will see a menu bar with multiple tabs. 

A Lower B Top C Lateral 
Q21:............. includes multiple tabs that you can use to create your presentation. 

A title bar B Scroll bar C menu bar 
Q22: ............. is a presentation page that contains text and images. 

A Slide B Chart C slide sorter 
Q23: you will see a …………………, or preview image, of each slide you’re creating.  

A Chart B Thumbnails C slide sorter 

Q24: To add another slide to your presentation, click on ................... 
A New file B New section C New slide 
Q25: To choose the layout of each slide, click the ………. icon on the Home menu. 

A Layout B Transitions C View 

Q26: …………… tab allows you to choose the background colors of the slides. 
A transitions B Design C view 

Q27: …………… tab allows you to choose a visual effect to  use between slides. 
A transitions B Design C slideshow 

Q28: ………… tab allows you Decide how you’d like to present and time each slide. 
A transitions B Design C slideshow 

Q29: The .............. tab allows you to Choose animated effects for each slide. 
A Design B View C Animation 

Q30: You can view the presentation by clicking.......... key on the keyboard. 
A F1 B F5 C F7 
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Complete the following sentences with suitable words from the brackets: 
(results - search engines - specific tasks - algorithms - coding – keywords) 

 
1-  ……………is a series of steps that explain how to perform a task.  

2-If the ………….. is not accurate, the results of the research may not be completely 
accurate.  
3-Algorithms help decide which……………..the most relevant to your research topic.  
4-…………Uses algorithms to give you results  
5- Computers and its applications use algorithms to perform ……………  

 

Complete the following sentences with suitable words from the brackets: 
(code - code.org - Wikipedia.org - mazes - coding) 

1 - ................. is writing multiple algorithms to create a complete program  
2 - You can create animations and games using ................  
3-................. website can help you learn coding using coding  languages  
4 - You can create ……… on code.org site, as it is an example of what can be created using 
coding   
 

Complete the following sentences with suitable words from the brackets: 
(Toolbox - Smart Art- Paint - Cropping - Menu Bar - Presentations) 

 
1- …………… is A popular graphics editor to create your own drawings or edit images  
2 - The top of the opening screen in the Paint includes the menu bar and .............  
3 – The editing features on the …….… include the ability to edit colors and images.  

4- You can select areas of the photo and cut them using the................  tool  
5 - Word also offers graphic tools t such as shapes, 3D models and ...............  
 

Complete the following sentences with suitable words from the brackets: 
(thumbnail - transition -animation - slide -f5 - layout) 

 
1-……………. is a presentation page that contains text and images.  
2-you will see …………, or preview image, of each slide you’re creating in PPT  
3-To choose the layout of each slide, click the ……… icon on the Home menu.  
4-......... tab helps you to Choose a visual effect to use between each slide.  
5-You can view the presentation by clicking........ key from the keyboard.  
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Put the word (true) in front of the correct statement and the word (false) in front of the 
incorrect statement as follows: 

1 Search engines use algorithms to give you results.  
2 Algorithms help determine the most relevant results for your search.  
3 An algorithm represents a series of steps that explain how to perform a task.  
4 A recipe of a meal  is not an algorithm type.  
5 If the keyword is inaccurate, the search engine algorithm will be accurate.  
6 coding is about writing multiple algorithms to create a complete program.  
7 You can create animations and games using the code.  
8 wiki.org helps you learn coding with different coding languages.  
9 You can create mazes on code.org as they are an example of what you can create with coding.  

10 PowerPoint is one of the popular programs for editing images and graphics.  
11 The top of the opening screen in Paint is similar in design to Word.  
12 The menu bar in Paint includes options for opening and saving files.  
13 Editing features in the title bar of Paint include the ability to edit colors and images.  
14 The toolbox includes all the tools you will need to design your drawing.  
15 You can select specific areas of a photo to use in your drawing with the cropping tool.  
16 You cannot change the image size or orientation in Paint.  
17 Skype also provides graphic tools that you can use to design graphic elements.  
18 to see the different graphic  options in word, click the Insert tab in the menu bar.  
19 3D models and Smart Art from different graphic options in Word.  
20 PowerPoint is used to design presentations that include different texts and effects.  
21 Each tab in PowerPoint includes a set of tools that help you create a presentation.  

22 There is a thumbnail for each slide you create for choosing a slide design.  
23 You can choose the layout of each slide in the layout tab.  

24 
To add text to your slide, click on the text box on the screen. Choose the font style and 
size you’d like to use. Type your text. 

 

25 there is no visual effects  in PowerPoint Presentation.  
26 Through the (Animation) tab, you can choose a visual effect to use between each slide.  
27 Through the (Transitions) tab, you can Choose animated effects for each slide.  

28 
Through the (Slide Show) tab, you can Decide how you’d like to present and time each 
slide. 

 

29 There is only one way to view the presentation.  
30 You can view the presentation by clicking on the view show  icon.  
31 You can view the presentation by clicking the f5 key on the keyboard.  
32 To insert a picture in your presentation, choose the Design tab, then the Pictures option.  

33 You can use wordy paragraphs and sentences in your presentation.  
34 When designing a presentation, make sure that the font type and size are readable.  
35 When designing a  presentation, Use relevant images instead of text whenever possible.  
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